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CREATE
a Stir!

IN 2026

Be Part of the Foodservice 
Industry’s Most Engaged 
Catering Community

Stir it up is more than a magazine - it’s a 

trusted partner to chefs, caterers, and 

foodservice professionals across the UK, 

Ireland and Europe. For over 17 years, we’ve 

built a reputation for delivering practical 

advice, creative inspiration and powerful 

brand exposure that drives real results.

Our unique format blends a printed 

magazine and digital platforms with a 

promotional brochure and specialist guides 

connecting suppliers directly with decision 

-makers through engaging, high-impact 

campaigns. From irresistible offers and 

standout recipes to thought-provoking 

features and expert insights, we help 

caterers bring your products to life in  

their kitchens.

What truly sets us apart? Every issue is 

hand-delivered straight to the people that 

matter – no junk mail, just direct access to 

chefs, managers, owners and their teams.

This year we’re continuing to spotlight 

what matters most across education, 

“I LIKE THE 

ARTICLES AND 

LOOK FORWARD 

TO READING 

THEM, THEY GIVE 

GREAT IDEAS!”

Why Stir it up works:  
We create content our 
readers genuinely want  
— because we ask them.

Each year, we conduct a readers survey 

to understand exactly what support, 

advice and inspiration caterers are 

looking for. This insight directly shapes 

our editorial calendar, from the features 

we write to the special guests we invite. 

This year, recipe inspiration, expert 

advice, new products and trend led 

insights top the list – making these the 

key areas where your brand can get 

involved and make an impact.

OF READERS ARE KEY 
DECISION MAKERS – 
OWNERS, CHEFS, AND 
MANAGERS

OF READERS SHARE THE 
MAGAZINE WITH OTHERS

90%

64%

60%

80%

SAY IT INFLUENCES 
THEIR MENUS

OF PURCHASING 
DECISIONS ARE DRIVEN 
BY STIR IT UP AND 
PROMOTIONS

care, welfare, and hospitality. From 

seasonal trends and sustainability to 

menu innovation, cost-saving tips and a 

celebrity chef or two along the way, Stir it 

up keeps your brand relevant, relatable 

and in front of caterers.

If you're looking to make a real impact 

and get your brand seen, there’s never 

been a better time to get involved.
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At Stir it up, we champion collaboration and creativity! Our editorial 

opportunities are open to all suppliers all year round and give you the chance 

to showcase your expertise, share your latest campaigns and highlight how 

your products can inspire and support caterers across the industry. Let’s work 

together to create standout content that puts your brand in the spotlight!

WITH STIR IT UP

UNLIMITED EDITORIAL
OPPORTUNITIES

CATEGORY FOCUS

Category Focus shines a spotlight 

on a key industry topic in each issue, 

offering caterers and chefs valuable 

insights, practical advice, and expert 

commentary — contribute your 

statistics, product knowledge, tips, 

and quotes from your team, along with 

high-quality imagery, to position your 

brand as a go-to industry voice and 

maximise your exposure.

MELTING POT

Melting Pot brings together creative 

ideas and inspiration from chefs, 

caterers, and foodservice brands, all 

centred around the theme of each 

issue. It’s a space to share practical 

tips, standout recipe ideas, and menu 

inspiration that helps others in the 

industry stay fresh and innovative 

– send us 75–100 words of themed 

content, the best of your recipe 

imagery, and include the contributor’s 

name, job title, and a recent photo to 

be featured and credited.

COOKS CALENDAR

Cooks Calendar highlights key 

food and drink dates with vibrant, 

relevant recipes and ideas to 

help caterers inspire menus, 

marketing, and more – share 

your recipes and product uses to 

get caterers inspired and feature 

in our Cooks Calendar!

ME WEIRD LINES HERE>>

ME WEIRD LINES HERE>>

OVER 
3030

,,
000000  

COPIES OF THE  STIR IT UP MAGAZINE  AND PROMOTIONS  ARE PRINTED  EACH ISSUE!
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IF YOU’D LIKE TO GET INVOLVED OR EXPLORE  

EXCLUSIVE ADVERTISING OPPORTUNITIES IN THESE 

TARGETED GUIDES, GET IN TOUCH — LET’S PUT YOUR 

BRAND AT THE HEART OF THE CONVERSATION.

MARKETPLACE

The Marketplace is your go-to feature for sharing  

product launches, updates to existing ranges, sustainability 

initiatives, research, and any company or market news – if 

you’ve got something to shout about, submit it to be featured in 

the SIU Marketplace.

AND SO MUCH MORE: 

Each issue of Stir it up features content that tackles the topics 

caterers care about most — from sustainability and mental 

health to staff training, new tech, and changing legislation.  

If you have a story, insight, or expertise to share, we want to 

hear from you.

Alongside the magazine, we also produce specialist 

guides like The Stir it up Guide to 2025 Food Trends and 

The Guide to Managing Allergens, as well as sector-

specific publications for care, education, and hospitality.

DÉLIFRANCE REPORT 
UNVEILS BRITS’ 
INCREASING PASSION 
FOR PASTRIES

Délifrance’s recent “Prove It: Viennoiserie” report reveals 

a growing British love for pastries, especially viennoiserie, 

which now surpasses overall bakery market growth. Key 

insights include a rise in impulse purchases and price taking 

precedence over freshness as a primary factor after quality. 

Sustainability awareness is also increasing, with many 

consumers wanting more transparency about the origins of 

their pastries. Classics like croissants and pain au chocolat 

remain favourites, while innovation and 

visual appeal continue to drive sales. 

Délifrance highlights that pastries offer 

a sense of indulgence, particularly amid 

challenging times.

Scan the QR code to read the full report

TTHHEE  MMAARRKKEETTPPLLAACCEE

Keeping you up-to-date on products and services within the foodservice industry

Nutritious and  Nutritious and  
SchoolSchool ––ApprovedApproved ::  

Cheerios Multigrain Cereal, now 

available for the education 

sector, meets England’s school 

food standards, making it a 

nutritious choice for school breakfasts. 

This popular UK cereal, packed with oats, wheat, and barley, provides 

high fiber and is fortified with essential vitamins (B2, B6) and minerals 

like iron and calcium, supporting students’ energy and immune 

function. Cheerios aims to give students a tasty, nutritious start to the 

day, aligning with its commitment to balanced diets.

BRING AUTHENTIC GLOBAL 
FLAVOURS TO YOUR KITCHEN  
WITH LION’S NEW SAUCES
Lion Sauces, a brand from AAK Foodservice, has expanded its range 

of globally-inspired cooking sauces, making it easier for chefs to 

quickly create authentic, flavourful dishes. With nine new sauces, 

including Arrabbiata, Balti, and Tikka Masala, these ready-to-use 

options blend convenience 

with high-quality ingredients, 

allowing chefs to serve 

diverse international flavours 

without the added prep time. 

Lion’s sauces, which are 

vegetarian, vegan-friendly, 

and free from artificial 

additives, aim to meet 

modern demands for  

both taste and simplicity  

in the kitchen.

Nestlé Professional’s new report, “Unlocking 

the Community Benefits of Regenerative 

Agriculture from Field to Fork,” highlights how 

regenerative farming revitalizes ecosystems 

and local economies. Collaborating with 

Footprint, Nestlé showcases how these 

practices benefit rural communities by creating 

jobs, boosting farmer incomes by up to 49%, 

and strengthening community connections. 

Initiatives like Nestlé’s partnership with First 

Milk provide financial incentives to farmers 

adopting sustainable practices, improving 

water quality and biodiversity. The report calls 

for industry-wide collaboration to maximize 

regenerative agriculture’s positive impact on 

local economies and ecosystems.

Nestle Professional Report Shows Regenerative Agriculture Nestle Professional Report Shows Regenerative Agriculture 
Boosts CommunitiesBoosts Communities

CHEERIOS 
MULTIGRAIN FOR  
UK STUDENTS

45

THE MARKETPLACE

“IT’S ALWAYS INTERESTING WITH  

NEW PRODUCTS COMING THROUGH  

FOR DIFFERENT MENU IDEAS.”
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EDITORIAL
REQUIREMENTS

For the first time, Stir it up is offering limited 

advertorial opportunities within the magazine. If 

you’re interested in submitting branded content 

that aligns with our themes and offers value 

to our readers, we’d love to hear from you. All 

submissions will be reviewed for relevance and 

fit, and availability is limited – so get in touch to 

discuss options and secure your spot!

ADVERTORIAL  
& SPONSORED 
CONTENT

Exclusive editorial opportunitiesExclusive editorial opportunities

DID YOU KNOW?
YOU CAN SUBMIT EDITORIAL THROUGHOUT THE YEAR FOR ANY ISSUE OF THE MAGAZINE.

LOW  

RESOLUTION

HIGH 

RESOLUTION

To provide editorial content for consideration in any of the  

features of the magazine please provide the following:

CCopopyy
•  A clear word document with the 

editorial copy. If it is a feature where  

we specify that we require a quote or  

a person to be specifically attributed  

to, then please provide their full name, 

job title and an up-to-date image of  

that person.

•  We try to include as much relevant 

information as possible for our readers, 

therefore please be aware that we are 

likely to edit the provided content.

ImagesImages
•  Any supporting imagery is to be 

provided in high resolution, 300dpi, 

CMYK, print ready JPG or TIFF  

at an appropriate file size.

•  Please note that any images submitted 

for use within the Stir it up magazine 

features may also be used to support 

those features across our Stir it up 

website and social media platforms. If 

you are not happy with this, please let 

us know so we can ensure that they are 

not used anywhere other than in the 

printed magazine.
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JAN/FEB

CATEGORY FOCUS

Cutting Edge Food Trends

MELTING POT

Creative Ways to Refresh Your 

Menu Seasonally

COOKS CALENDAR

Veganuary, Chinese New Year, 

Hot and Spicy Food Day, 

Valentine’s Day, Pancake Day

MAY

CATEGORY FOCUS

Food Tourism

MELTING POT

A Trip to India - From  

Regional Specialities  

to Street Food  

Fusion

COOKS CALENDAR

World Baking Day, National  

BBQ Week, National Biscuit  

Day, Sandwich Week

NOV/DEC

CATEGORY FOCUS

Seasonal Seafood

MELTING POT

Retro Revival - 80s and 90s Food 

Trends with a Modern Twist

COOKS CALENDAR

World Sandwich Day,  

Bonfire Night, English  

Breakfast Day, Christmas

MARCH

CATEGORY  

FOCUS

Elevating Food  

on the Go

MELTING POT

Fusion Desserts

COOKS CALENDAR

Mother’s Day, British Pie Week,  

St Patrick’s Day,  

International  

Waffle Day

SEPTEMBER

CATEGORY FOCUS

Breakfast and Brunch

MELTING POT

Classic Comfort Foods 

with Gourmet Twists

COOKS 

CALENDAR

Sourdough 

September, Welsh 

Rarebit Day, Bacon 

Butty Day

JUNE

CATEGORY FOCUS

Wellness Week Menus to  

Engage Students

MELTING POT

Keeping Diners and Residents 

Hydrated

COOKS CALENDAR

Father’s Day, World Tapas Day, 

World Milk Day, Fish and Chips 

Day, International Picnic Week 

APRIL

CATEGORY FOCUS

Superfoods in Senior Dining

MELTING POT

Traditional Recipes and 

Heritage Cooking 

Techniques

COOKS CALENDAR

Easter, Great British Beef  

Week, World Health 

Day, National Tea Day

OCTOBER

CATEGORY FOCUS

Space-Saving Kitchen Equipment

MELTING POT

Catering for Dietary Restrictions 

for the Festive Season

COOKS CALENDAR

National Curry Week, Yorkshire 

Pudding Day, Potato Day, World 

Pasta Day, National Honey Day

JULY/AUG

CATEGORY FOCUS

Cooling Desserts  

for the Summer  

Months

MELTING  

POT

Midnight Menus - Catering to  

the Night Time Crowd

COOKS CALENDAR

Chocolate Day, Cherry Day, Ice 

Cream Day, Burger Day, Cupcake 

Day, Afternoon Tea Week 

FOCUS EDITORIAL TOPICS
for 2026 for 2026 
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FULL PAGE OR 

BACK COVER

Trim: 210mm x 297mm

Type: 194mm x 281mm

Bleed: 216mm x 303mm

DOUBLE PAGE SPREAD

Trim: 297mm x 420mm

Type: 281mm x 404mm

Bleed: 303 mm x 426mm

HALF PAGE SPREAD

Trim: 420mm x 145mm

Type: 404mm x 129mm

Bleed: 426mm x 151mm

PRINT ADVERTISING

RATES & SPECIFICATIONS

ADVERT SPACES ARE LIMITED, SO SUBMIT YOUR 2026 BOOKING FORM ASAP TO SECURE 
YOUR SPOT!

Dairy Ice Cream

regenerative farm and contains 

donated to the Natasha Allergy 

TASTE GOOD, BUT IT

VANILLA DAIRY 

ICE CREAM

6 x 4Ltr

SCOOP
Perfect

Bleed

Type

Trim

Crop Marks
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Size
x 1 

insertion
2 - 5 

insertions
6 + 

insertions

Double page spread £5,400 less 5% less 10%

Full page £2,880 less 5% less 10%

Half page spread £2,880 less 5% less 10%

Half page horizontal £1,940 less 5% less 10%

Half page vertical £1,940 less 5% less 10%

Back cover £3,500 less 5% less 10%

InvestmentInvestment

Please do not include any pricing or promotional mechanic on any of the adverts that are submitted for inclusion  

within the magazine.

HALF PAGE 

HORIZONTAL

Trim: 210mm x 145mm

Type: 194mm x 129mm

Bleed: 216mm x 151mm

HALF PAGE  

VERTICAL

Trim: 105mm x 297mm

Type: 89mm x 281mm

Bleed: 201mm x 303mm

Media specificationMedia specification
All print ready advertising  

artwork must be sent to  

stiritup@countryrange.co.uk  

on or before the specified deadline  

as detailed in the Deadline Calendar.

ACCEPTABLE FILE 

FORMATS:

Our preferred format is Adobe Acrobat 

PDF, these must be:

•  High resolution (press optimised)

•  Fonts embedded

•  Pre-flight check advisable

OTHER ACCEPTABLE 

FILE FORMATS 

INCLUDE:

•  Photoshop TIFF, EPS (CMYK 

300dpi), Illustrator EPS (fonts 

outlined, linked graphics)

•  We do not accept open documents 

of Quark, InDesign and Illustrator

Get the most impact out of your print adverts by running a combined 

print and digital campaign. Talk to us to find out more!
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INVESTMENT

THESE MAGAZINE FEATURES ARE AVAILABLE 

FOR AN ADDITIONAL COST AND ARE MADE 

BESPOKE TO YOU! TALK TO OUR

TEAM TO FIND OUT MORE.

FOLD OUT 

PAGES

In addition to the advertising and editorial opportunities available, 

we can provide additional print opportunities to maximise your 

brand campaigns. 

From taking over the front cover of Stir it up with belly bands or corner 

pockets to providing tear out inserts or mini recipe booklets – we’ve  

got you covered.

BELLY BANDS  

AND WRAPS

A belly band wraps  
around the whole mag,  
a belly wrap tucks in the 
centrefold and can open 
up on a desired advert.

Full standard size: 
694mm x 70mm

Fold in area:  
135mm x 70mm  
on either side

CORNER 

POCKETS

Multiple shape  
and die line  
options available

SAMPLES  

AND INSERTS

Multiple size options available.

ADDITIONAL PRINT 

OPPORTUNITIES

GOT A  

UNIQUE IDEA? 

GET IN TOUCH  

WITH US TO SEE  

IF WE CAN MAKE  

IT A REALITY. 
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TILE

Static graphic on either homepage,  

sector page and related post  

and recipe pages

• 600px x 600px

• Leave 30 px border all round 

• Leave top left corner clear

• File format: JPG/GIF

• Can link internally or externally

ENHANCED TILE

1 x static graphic on either 

homepage, latest news and  

related post and recipe pages

• 1632px x 510px

• Leave 30 px border all round

• Leave top left corner clear

• File format: JPG/GIF

• Can link internally or externally

SIDEBAR ADVERT

1 x sidebar graphic on 

marketplace, latest news  

or recipe pages

• 600px x 1200px

• Leave 30 px border all round

• Leave top left corner clear

• File format: JPG/GIF

• Can link internally or externally

The online opportunities available through the 

Stir it up website and across our social media 

platforms complement our printed magazine.  

Get the most out of your advertising campaigns 

by running both print and digital adverts at the 

same time!

FOLDING TILE

Expanding graphic on either  

home, sector page and related  

post and recipe pages

• 2265px x 350px - visible 

 2265px x 700px - expanded

• Leave 30 px border all round 

• Leave top left corner clear

• File format: JPG/GIF

• Can link internally or externally

DIGITAL  

ADVERTISING

RATES &  

SPECIFICATIONS

for the Stir it up  for the Stir it up  
websitewebsite
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STICKY BOTTOM BANNER

A static banner that sticks to the  

bottom of the screen – only available as part 

of the homepage and sector page takeovers 

• 1980px x 150px - background  

 image: no text, JPG

 660px x 75 px - centre graphic:   

 transparent background, PNG/GIF

 600px x 400px - overlay: 

 transparent background, PNG/GIF

• Leave 20 px border top and bottom

• Can link internally or externally

TOP OF PAGE BANNER 

A static banner above the header – only 

available as part of the homepage and sector 

page takeovers 

• 1980px x 150px – background 

 image: no text, JPG 

• 660px x 75 px - centre graphic: 

 transparent background, PNG/GIF 

• Leave 20 px border top and bottom

• Can link internally or externally

RECIPE PAGE TILE 

A static graphic on up to 9 selected recipe pages

• 600px x 340px

• Leave 30px border all round

• Leave top left corner clear

• File format: JPG/GIF

• Can link internally or externally

4 BLOCK TILE

Static graphic on either home or sector pages

• 600px x 340px

• Leave 30 px border all round

• Leave top left corner clear

• File format: JPG/GIF

• Can link internally or externally

BILLBOARD - HOMEPAGE

1 x sliding graphic on homepage

• 1920px x 1080px -  

 background: no text, JPG

 1470px x 770px - billboard graphic:   

 transparent background, PNG/GIF

• Leave 30 px border all round

• Leave top left corner clear

• Can link internally or externally

• For mobile please supply 1x title graphic

BILLBOARD - 

 SECTOR PAGE

1 x sliding graphic on  

a sector page

• 1920px x 1080px -  

 background:  

 no text, JPG

 1470px x 770px -  

 billboard graphic:     

 transparent  

 background,  

 PNG/GIF

• Leave 30 px  
 border all round

• Leave top left  
 corner clear

• Can link internally  or externally

• For mobile please supply 1x title graphic “WE LOOK 

FORWARD  

TO EVERY 

 ISSUE OF  

STIR IT UP!”
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Digital Advert Cost

Tile £1,100

Folding Tile £1,800

Enhanced Tile £1,100

Sidebar Advert £1,500

Billboard - Homepage £3,500

4 Block Tile £1,100

Billboard - Sector Page £2,000

Homepage Takeover £6,000

Sector Page Takeover £3,500

Brand Page & Recipe Pack £1,650

Brand Page & Tile Recipe Pack £2,200

Brand Page & Folding Tile Recipe Pack £2,750

Recipe Page Tile £750

ALL DIGITAL PACKAGES RUN FOR A CALENDAR MONTH

HOMEPAGE TAKEOVER

A full takeover of the Stir it up homepage

• 1x Tile

• 1x Homepage Billboard

• 1x Sticky Bottom Banner

• 1x Top of Page Banner

SECTOR PAGE TAKEOVER

A full takeover of either the Education, Care or 

Hospitality sector page

• 1x Tile

• 1x Homepage Billboard

• 1x Sticky Bottom Banner

• 1x Top of Page Banner

InvestmentInvestment

Something  
Something  MissingMissing?  If there is an idea not listed  

here or you would like a bespoke 

package created from the different 

elements, our experienced  

team is available to discuss and  

tailor a package to suit your  

needs. Please contact  

stiritup@countryrange.co.uk  

to discuss further.
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Want  to go biggerWant  to go bigger? ? 

We also offer bespoke joint social campaigns and  

competitions that include:

• Custom posts, stories, and reels

• Tailored prize packages to boost engagement

• Platform-specific copywriting and visuals

• Full campaign management, including audience engagement  

and community moderation

• All shared with our members

Our social platforms are a powerful way to increase your  

brand visibility and connect with a community of  

engaged caterers.

SOCIAL MEDIA 

OPPORTUNITIES

LetLet ’’s get social!s get social!
We love sharing great content — and if you’ve got something worth shouting about, we want to see it! 

From standout recipes and product inspiration to exciting news and campaigns, simply send  

us your social content throughout the year and we’ll help amplify it across  

our growing platforms.

All our social activity can be tailored to support your broader 

campaigns or be unique to the SIU community, so contact our 

team to explore opportunities for collaboration.

• https://www.linkedin.com/company/stiritup/  

• https://www.instagram.com/stiritupmag/ 

Brand PagesBrand Pages
Enhance your brand’s visibility with our brand page and recipe packs. Get your own fully branded landing page featuring 

up to nine of your recipes, editorial submissions and optional custom text and external links. To maximize exposure,  

a selection of your recipes will also be showcased as featured content across our homepage and recipe page.

BRAND PAGE &  

RECIPE PACK

Creation of a dedicated brand 

page with recipes and editorial

BRAND PAGE &  

TILE RECIPE PACK

Creation of a dedicated brand page 

with recipes and editorial with 1 x tile 

placement

BRAND PAGE & FOLDING 

TILE RECIPE PACK

Creation of a dedicated brand page 

with recipes and editorial with 1 x folding 

tile placement

• Brand logo

• Banner image - no text in the graphic

• File format: JPG/GIF

• See folding tile asset spec

• Brand logo

• Banner image - no text in the graphic

• File format: JPG/GIF

• See folding tile asset spec

• Brand logo

• Banner image -  

 no text in the graphic

• File format: JPG/GIF

JOIN THE SOCIAL COMMUNITY

We love getting social. If you have any social content 

that you would like to share with us throughout the 

year then simply send it to us. There are also 

opportunities for some bespoke social campaigns.

stiritup             stiritupmag

https://www.linkedin.com/company/stiritup
https://www.instagram.com/stiritupmag/?hl=en


SUPPLIER ADVERTISING AND MEDIA PACK 2026 

14

OTHER OPPORTUNITIES
Unlock even more ways to get your brand seen beyond 

traditional advertising, Stir it up offers a variety of 

creative and impactful opportunities designed to put  

your brand in front of engaged caterers and decision-

makers. From exclusive seasonal campaigns and 

inspiring recipe guides to dynamic digital takeovers, 

these options help you reach your audience in fresh, 

memorable ways. Whether you’re looking to boost 

visibility, drive engagement, or align with key industry 

themes, we’ve got unique solutions to fit your goals.

JOIN THE 
COUNTRY CLUB

Exclusive to Country 

Range Group customers 

our Country Club 

competition is a much-loved 

feature, offering exciting prizes 

every issue based on current 

themes, trends and guest  

features – and now, you  

can get involved too!

Join the Country Club by sponsoring 

a prize and enjoy added brand 

exposure across the magazine, 

social channels and website. It’s a 

great way to boost visibility whilst 

supporting the Stir it up community 

with memorable rewards and 

experiences.

STIR IT UP ADVENT 
CALENDAR

Celebrate the most wonderful 

time of the year with our exclusive 

Advent Calendar competition for 

Country Range Group customers. 

This festive campaign takes over 

our Nov/Dec cover, and gives you 

the chance to sponsor an advent 

calendar door, have your own 

dedicated competition landing page 

and sponsor a standout prize — all 

supported with exposure across 

our social channels.

Group TakeoversGroup Takeovers
Our most exclusive campaign  

opportunity, the Group Takeover 

offers key branded suppliers  

the chance to invest in a high-

impact, multi-channel marketing 

campaign across the entire Country 

Range Group.

Delivered through Stir it up’s print 

and digital platforms — and  

mirrored across individual Group 

wholesaler channels* — this 

campaign gives your brand 

standout exposure across:

• Stir it up Promotions

• Stir it up Magazine

• Stir it up Website

• Social Media Channels

• Member Wholesaler Websites

• Plus additional activities such as 

 RARA Days and Focus Weeks  

 with our members

With limited availability and 

exceptional reach, the Group 

Takeover is the ultimate way to get 

your brand seen by thousands of 

engaged caterers.

Interested? Get in touch with our  

team today — spaces are limited 

and go fast!

*Dependent upon member capabilities

EDUCATION   
menu solutions guide

1

M
A

N
A

G
I

N
G

A
L

L
E

R
G

E
N

S

A GUIDE TO:

Want to get  

involved? Contact our 

team to secure your 

spot and spread some 

festive cheer while 

boosting your  

brand!

STIR IT UP GUIDES

Throughout the year, we’ll be 

producing a series of concise trend 

reports and sector-specific guides 

to equip caterers with key market 

insights, data, and inspiring recipes.

Want to get involved? Contact our 

team at stiritup@countryrange.co.uk 

to find out how your brand can  

be featured.
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# OUR BUYING IN DATES ALWAYS REFER TO DATE OF ORDER. 

Therefore all orders placed by members within the promotion period would qualify for any ‘off-invoice’ discount 

offered. If your invoicing systems work on any other period of time, i.e. Date of Delivery, you will need to adapt  

your own input information to ensure that members’ orders are captured and processed correctly.

All editorial and print advertising must be received by the specified deadline, if you miss a deadline or miss  

an advert submission completely you may still be charged.

Period

Supplier Proposal 
Deadline

Promotions & 
advert details to 
reach us before:

Editorial 
Deadline

Artwork 
deadline

All magazine 
artwork 
due in

# 
Buying 
in dates

From To Sell

Selling out 

dates
Monday Friday Duration

January 19.09.25 16.10.25 23.10.25
Buying In 08.12.25 30.01.26

4 weeks
Selling Out 05.01.26 30.01.26

February
(Promotions only)

08.10.25 N/A N/A
Buying In 05.01.26 27.02.26

4 weeks
Selling Out 02.02.26 27.02.26

March 05.11.25 11.12.25 18.12.25
Buying In 02.02.26 27.03.26

4 weeks
Selling Out 02.03.26 27.03.26

April 10.12.25 15.01.26 22.01.26
Buying In 09.03.26 01.05.26

5 weeks
Selling Out 30.03.26 01.05.26

May 14.01.26 12.02.26 19.02.26
Buying In 06.04.26 29.05.26

4 weeks
Selling Out 04.05.26 29.05.26

June 11.02.26 12.03.26 19.03.26
Buying In 04.05.26 26.06.26

4 weeks
Selling Out 01.06.26 26.06.26

July 18.03.26 16.04.26 23.04.26
Buying In 08.06.26 31.07.26

5 weeks
Selling Out 29.06.26 31.07.26

August
(Promotions only)

16.04.26 N/A N/A
Buying In 06.07.26 28.08.26

4 weeks
Selling Out 03.08.26 28.08.26

September 20.05.26 18.06.26 25.06.26
Buying In 10.08.26 02.10.26

4 weeks
Selling Out 31.08.26 02.10.26

October 17.06.26 16.07.26 23.07.26
Buying In 07.09.26 30.10.26

5 weeks
Selling Out 05.10.26 30.10.26

November/

December
15.07.26 20.08.26 27.08.26

Buying In 12.10.26 01.01.27

8 weeks
Selling Out 02.11.26 01.01.27

20262026 DEADLINE CALENDAR

WORRIED YOU 

WILL MISS A 

DEADLINE?  

GET IN TOUCH WITH 

OUR TEAM AND WE WILL 

SEE WHAT WE CAN DO 

TO HELP YOU! 
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InDesignInDesign
SETUP

File > Document setup > Bleed and Slug

•  Bleed: 3mm

•  Margins: 16mm

IllustratorIllustrator
SETUP

File > New

•  Bleed: 3mm

•  Colour Mode: CMYK

•  Raster Effects: 300ppi

View > Rulers: Show Rulers. You can drag out the 

guides to create a safe area for your copy.

HOW TO EXPORT TO PRINT
Cheat SheetCheat Sheet

EXPORT

File > Export

•  Format: Adobe PDF (PRINT) > Save

•  Adobe PDF Preset: Press Quality

•  Compression: Untick ‘Compress Text and 

Line Art’

•  Marks and Bleeds: Tick ‘Crop Marks’ Tick: 

‘Bleed Marks’ Weight: 0.50pt, Offset: 3mm

•  Tick ‘Use Document Bleed Settings’ (3mm)

Export

EXPORT

File > Save As

•  Format: Adobe PDF > Save

•  Adobe PDF Preset: Press Quality

•  Compression: Untick ‘Compress Text and 

Line Art’

•  Marks and Bleeds: Tick ‘Crop Marks’ Tick: 

‘Bleed Marks’ Weight: 0.50pt, Offset: 3mm

•  Tick ‘Use Document Bleed Settings’ (3mm)

Save PDF
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CanvaCanva
SETUP

File > Settings: Show Rulers and Guides.  

You can drag out the guides to create a  

safe area for your copy.

File > Settings: Show Print Bleed

Design GlossaryDesign Glossary
CROP MARKS – These are small black 

lines or ‘marks’ that sit 5mm or so from the 

corners of the artwork. They show the printer 

where the edge of the page or artwork is and 

where to cut or ‘crop’ from.

TRIM – The final size of your printed piece 

after it has been cut along the crop marks.

BLEED – An extra area of colour or images 

that extends beyond the final trim line to ensure 

no unprinted edges appear after cutting.

CMYK – An abbreviation for the four ink 

plates used in the printing process: cyan, 

magenta, yellow, and key (black). This colour 

model is standard for printed materials.

EXPORT

File > Download 

•  File Type: Pdf Print 

•  Tick ‘Crop Marks and Bleed’

•  Colour Profile: CMYK

Select Download

Note: Canva is an RGB colour mode 

programme so if you then export to print, it 

will change your colours to CMYK and they 

will look different/muted - this is normal.

We recommend using Adobe InDesign or Illustrator when preparing print files, as these programs 

are specifically designed for professional print production. Canva is primarily intended for digital 

and web use, and is not the most suitable option for creating high-quality print materials.

RGB – The abbreviation refers to the three 

colour model: red, green, and blue which add 

together to create the different colours you 

see on a screen.

300 DPI – (dots per inch) is a widely 

accepted standard for high-quality printing, 

meaning that a printer will place 300 

individual dots of ink within every inch of  

a physical image, resulting in sharp and  

clear visual.

RULERS AND GUIDES –  

Non-printing tools in your workspace that 

help you align and position elements on a 

page or canvas.
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